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Adobe Premiere CC 2015: Basics

Setting up your project

Creating a project folder on an external hard drive

When you work on a project in Adobe Premiere, your project file (the .prproj file) 
references your media files (video files, audio files and images) and scratch disks (folders 
that make digital video editing possible.) 

In order for your project to work correctly, you’ll need to keep your project file, media 
files and scratch disks in the same location. To make sure these files and folders are 
always in the same location, you keep everything in a project folder.

1. Connect a Mac-formatted external hard drive to the back of a JAMS lab computer. 
Control-click within the external hard drive to bring up a fly-out menu. In the fly-
out menu, choose New Folder. 

2. Give the folder a name relevant to your project. If you need to move your project to 
a new location, you will move your project folder (an everything inside of it) to the 
new location. 

Adding media files from an iPad or iPhone to your project folder

1. Transfer the media files on your iPad or iPhone to your project folder (see 
iPhone and iPad: Transferring images or videos to a thumb drive or external 
hard drive on Tech Resources for Students.)

Project folder with media files, scratch disks and project file (.prproj) in same location.



Adding video files from a digital video camera to your project folder

When importing footage filmed with a digital video camera, always connect the camera to 
a JAMS lab computer using the supplied USB cable.

1. Turn on digital video camera.
2. Connect the supplied USB cable to the digital video camera. Then connect the 

USB cable to one of the USB ports on the back of a JAMS lab computer. (Note: Do 
not connect the USB cable to USB port on the keyboard.) 

3. Check the camera’s LCD screen display. At this point, most digital video cameras 
will ask you where your video footage resides (it’s usually on an SD card or the 
camera’s internal hard drive.) Select the area where your footage resides. (Note: Be 
sure to select the correct SD card slot if the camera has multiple SD card slots.)

4. Open a new Finder window (click Desktop, then press Command-n.) The SD card 
(or the camera’s internal hard drive) will display under Devices (it may appear 
as Untitled and contain a PRIVATE folder.) In the Finder window, select this area 
under Devices.  

5. In a new Finder window, open your project folder.
6. Copy everything in the in the digital video camera Finder window to your project 

folder. (Note: It is of the utmost importance that you copy the entire digital video 
camera folder structure into your project folder. Do not bring individual video files 
from the camera into your project folder. If the folder structure is altered in any 
way, the video files will not work.) 

Adding audio files to your project folder

As with video and image files, audio files (MP3, WAV, etc.) must be brought into your 
project folder before being added to your Premier project.

1. To transfer audio files recorded with a Zoom H2, see Zoom H2 Recorder: Basics on 
Tech Resources for Students.

2. To add other audio files (music, for example) to your project folder, simply click 
and drag the files into your project folder. 

Creating a new Adobe Premiere project and setting a scratch disk locations

1. On a Mac, click on the Desktop to enter Finder mode. Select Go on the menu bar 
and choose Applications. Double click Adobe Premiere Pro CC 14 (and then 
double click it again.)

2. In the Adobe Premiere welcome screen, click Create New Project.
3. Enter a name for your project in the Name field. 
4. In the Location area, click the Browse button. Navigate to your project folder on 

your external hard drive (JAMS 602.) Click Choose.
5. To confirm that the scratch disk location is in the same place as your project file, 

click the Scratch Disks tab. All fields in this area should display Same as Project.
6. Click OK.



Opening an existing project and confirming scratch disk locations

1. On a Mac, click on the Desktop to enter Finder mode. Select Go on the menu bar 
and choose Applications. Double click Adobe Premiere Pro CC 14 (and then 
double click it again.)

2. In the Adobe Premiere welcome screen, click Open Project.
3. Navigate to and select your project on your external hard drive (JAMS 602.) Click 

Open.
4. Click File on the menu bar and then choose Project Settings and select Scratch 

Disks.
5. Confirm that all fields display Same as Project and click OK.

Importing and logging clips

Importing media files into your project

Before you can edit your media files, you’ll need to Import them into your project.  

1. Go to File on the menu bar and choose Import. Navigate to your project folder 
and the select the media files you would like to add to your project. (Note: you can 
Command-click multiple video files to bring in several video files at the same time.)

2. Click Import. Your media files will appear in the Project window. 

Previewing a media file in the Source window

The Source window allows you to preview a media file.

1. In the Project window, double-click a media file. The media file will display in the 
Source window. 

2. To play a video or audio file in the Source window, press the spacebar on your 
keyboard. 

In and Out points added to video clip in Source window.



Renaming clips in Project window

1. In the Project window, select a media file and then click its name.
2. Give the media file a new name.

Adding In and Out points to a video clip

In the Source window, you can add In and Out points to a clip before adding the footage to 
your Timeline.

1. In the Project window, double-click a video clip. The video clip will display in the 
Source window. 

2. In the Source window, play your video clip to get a sense of the section of video you 
would like to add to your Timeline. 

3. To add an In point to your video clip, position the Playhead at the point where you 
would like the In point to appear. Press i on your keyboard to add the In point. 

4. To add an Out point to your video clip, position the Playhead at the point where 
you would like the Out point to appear. Press o on your keyboard to add the Out 
point. 

Creating a sequence 

1. To create a Sequence, click and drag a video clip from the Source window into 
the Timeline. Premiere will automatically create a new Sequence based on the 
settings of the video clip. 

2. By default, your sequence will have the same name as the clip you brought into the 
Timeline. Select your sequence in the Project window and give it a new name. 
(Note: A sequence has a different icon than the video clips in the Project window.)

Premiere project with video and audio clips in the Timeline.



Adding clips to timeline

1. Open a clip in the Source window and set In and Out points. 
2. Click and drag the clip from the Source window into the Timeline. 
3. Repeat this process for all clips you would like to add to the Timeline.

Previewing a project in the Program window

The Program window allows you to preview your edited project.

1. Click within the Timeline area. Position the Playhead at the beginning of the 
Timline.

2. To play a your edited project in the Program window, press the spacebar on your 
keyboard.

 
Saving your project

1. Go to File on the menu bar and choose Save.
2. Note: Always keep your project file, media files and your scratch disks in the same 

location. Never move, rename or delete the files and folders in your project folder. 

Editing in the Timeline

When arranging your video clips in a Sequence, the topmost video track layer will be 
visible in the Program window. The topmost clip will therefore be the clip that displays in 
your finished product video file as well. 

Although video from the topmost video item displays in the Program window, it is not 
necessarily the audio of this video clip that gets factored into the finished product. Audio 
from a different source (an audio file, a different video clip, etc.) can play under the footage 
playing in the topmost video track.

Arranging clips in a sequence

1. Make sure the Selection Tool is active in the Tool window.
2. Click and drag clips in the Sequence to rearrange the order in which they appear. By 

default, a clip will snap to the clip nearest to it. To turn this feature on or off, click the 
Snap tool (or press S on your keyboard.) 

Removing clips from a sequence

1. Make sure the Selection Tool is active in the Tool window.
2. In the sequence select the clip you would like to remove. The video clip and its audio 



will appear highlighted. 
3. Press the Delete key on your keyboard. 

Zooming in and out of a sequence

Sometimes you won’t be able to see everything in your sequence at the same time, so you’ll 
need to use the zoom controls.

1. Use the + or – keys on your keyboard to zoom in or zoom out of your sequence.
2. You can also use the slider beneath the Timeline to adjust the overall view of your 

Sequence. 

Muting clip audio while working in Timeline 

When working in the timeline, clip audio will play as you move the Playhead. To turn this 
feature on or off, you can enable or disable scrub timeline audio. 

1. To turn scrub timeline audio on or off, press Shift-s on your keyboard. 

Trimming clips in timeline

1. Make sure the Selection Tool is active in the Tool window.
2. Hover your mouse pointer over the left or right edge of a clip in the Timeline. Your 

mouse pointer will become red Trim tool. 
3. With Trim tool active, click and drag to trim or extend the duration of the clip in the 

Timeline. 

Project window with Tools window on the right.



Creating an overlay edit

1. Make sure the Selection Tool is selected in the Tool window.
2. Click the video portion of a clip in the Timeline. 
3. Drag the video portion of the clip up in the video track area of the Timeline. The 

video and audio portions of the clip will separate—each moving towards the top and 
bottom of the Timeline, respectively.  

4. Position the video of the overlay clip above the video of another clip in the Timeline. 
The video of the overlay clip will play in the Program window while the audio of 
clip beneath it plays as well. 

Splitting a clip in timeline 

Occasionally, you may need to split a clip after you’ve added it to the Timeline. To do this, 
you can use the Razor Tool. 

1. In the Timeline, position the Playhead where you would like the split to occur. 
2. In the Tools window, select the Razor Tool. 
3. To split the clip in the Timeline, click the clip with the Razor Tool.  
4. When you’re finished working with the Razor Tool, click the Selection Tool in the 

Tools window. 

Separating audio and video of a clip

1. Make sure the Selection Tool is selected in the Tool window.
2. Select the clip in the Timeline. 
3. Control-click the clip.
4. In the fly-out menu, select Unlink. The audio and video portions of the clip will now 

operate separately in the Timeline. 

Working with Audio

Using mute and solo controls

1. To mute the audio of a track in the Timeline, click the M (mute) button in the audio 
track controls.

2. To play the audio of only one track in the Timeline, click the S (solo) button in the 
audio track controls.  

Adjusting audio levels with Audio Clip Mixer

1. In the Timeline, select the clip you would like to adjust. 
2. Go to Window on the menu bar and select Audio Clip Mixer.
3. Play the clip in the Timeline to monitor the audio levels in the Audio Clip Mixer. 



The audio track names in the Audio Clip Mixer correspond to the audio track 
names in the Timeline (A1 in the Timeline is A1 in the Mixer, etc.)

4. To adjust the audio level of the clip, click and drag the track’s Fader in the Audio 
Clip Mixer. (Note: audio levels should generally be between -12 and -6 db.) 

5. To exit the Audio Clip Mixer, go to Window on the menu bar. Choose Source 
Monitor and select your clip from the fly-out menu. 

Adding transitions and titles

Applying transitions

As a general rule, transitions should be used sparingly in your video project. If you do 
apply a transition to a clip, you should be able to explain why it was added to your project 
(a Cross Dissolve added to indicate the passing of time, for example.) 

Aside from a standard cut (in other words, no transition), you should stick to two types of 
transitions: 

•	 Cross dissolve (“fade in and out”)
•	 Dip to color dissolve (“fade to black”)

Applying a cross dissolve

1. Go to Window on the menu bar and select Effects. The Effects tab will display in the 

Audio Clip Mixer. Adjust audio level by clicking a dragging fader (currently at 0.)



Project window area. 
2. In the Effects window, click the Expand button (triangle) next to Video 

Transitions.
3. Click and drag the Cross Dissolve icon to the area where you would like the 

transition to appear (at the beginning of clip or between two clips.) You will see the 
Cross Dissolve added to the clip (or clips) in the Timeline.

4. To adjust the duration of the Cross Dissolve, Control-click the transition in the 
Timeline. From the fly-out menu, choose Set Transition Duration. 

5. In the Set Transition Duration dialog box, enter a new duration for your transition. 
(Note: Duration format is: Hours:Minutes:Seconds:Frames.)

6. Click OK to apply the new Transition duration. Repeat this process for all other 
Cross Dissolve transitions.

Applying a dip to black transition

1. Go to Window on the menu bar and select Effects. The Effects tab will display in the 
Project window area. 

2. In the Effects window, click the Expand button (triangle) next to Video 
Transitions.

3. Click and drag the Dip to Black icon to the area in the Timeline where you would 
like the transition to appear (at the beginning of clip or between two clips.) You will 
see Dip to Black added to the clip (or clips) in the Timeline.

4. To adjust the duration of the Dip to Black, Control-click the transition in the 
Timeline. From the fly-out menu, choose Set Transition Duration. 

5. In the Set Transition Duration dialog box, enter a new duration for your transition. 
(Note: the duration format is: Hours:Minutes:Seconds:Frames.)

6. Click OK to apply the new Transition duration. Repeat this process for all other 
Dip to Black transitions.

Effects window. Click and drag a transition to a clip in your Timeline to apply it 
to your project. 



Adding titles

1. On the menu bar, go to Title, New Title. From the fly-out menu, choose Default 
Still.

2. A settings box will appear. Click OK.
3. A Title window will appear. You will use this box to create a title still (similar to a 

transparent image) that will appear in your Project window (along with your video 
clips.) 

4. Make sure the Type tool is selected. Click on video image in the Title window. A 
cursor will appear. Add your title text here (there is no spell check, so double-check 
your spelling and grammar.) 

5. To change your title text font, drag-select your text. Then, in the Title Styles area, 
select a new font and format for your title. 

6. To reposition your title text, click the Selection Tool (Note: Be sure to click the 
Selection Tool in the Title window tools area.) With the Selection Tool active, 
click and drag your title text to reposition it. (Note: All of your text should be within 
the title safe area—the inner lines in the title preview box.)

7. When you’re finished creating your title, close the Title window. You will see a title 
added to your Project window (it will probably be named “Title 01.”)

8. To add your title to your project, click and drag the title still from the Project 
window to your Timeline. The title should be in the topmost video track. 

9. Adjust the duration of the title just as you would a video clip (click and drag 
beginning or end of title still in the Timeline.) 

10. Add a Cross Dissolve transition to the beginning and end of the title still in the 
Timeline. (Note: you will probably need to adjust the duration of the crossfade on 
your title still.) 

Title window. 



Exporting 

Exporting your project as an MOV file

You’ll export an MOV file as your finished product. You can upload this MOV file to 
YouTube or Vimeo.

1. Important: Make sure you have the Timeline area selected before exporting your 
video (click in Timeline area—Timeline area will have a yellow border around it.) 
If you have only one clip selected in the Project window, Premiere will export only 
that clip (not your entire project.) 

2. Go to File on the menu bar. Select Export. From the fly-out menu, select Media.
3. In the Export dialog box, under in the Format drop-down list, select QuickTime. 
4. In the Source Range drop-down list, choose Entire Sequence.
5. To specify the name and location of your exported video, click the Output Name. 

A Save As dialog box will appear. Rename your video. In the Where field, specify 
where your finished video will appear when Adobe Premiere has finished exporting 
it. Click Save. (Note: Do not change the File Format in the Save As dialog box.)

6. Click Export.

Export Settings dialog box.


